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CONTENTS

Overview
What is the Siemens TCP/IP Unsolicited Ethernet Driver?

Setup
How do I configure a device for use with this driver?

Data Types Description
What data types does this driver support?

Address Descriptions
How do I address a data location on a Siemens TCP/IP Ethernet device?

Event Log Messages
What messages does the driver produce?

Overview
The Siemens TCP/IP Unsolicited Ethernet Driver provides a reliable way to connect Siemens TCP/IP Slave
Ethernet devices to client applications; including HMI, SCADA, Historian, MES, ERP, and countless custom
applications. This driver actd as a simulated Siemens PLC. It is intended for simulation of Siemens S7-300.
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Setup
The Siemens TCP/IP Unsolicited Ethernet Driver supports one channel and up to 256 virtual devices.

Supported Protocols
S7 Messaging on Industrial Ethernet (ISO 8073 Class 0) over TCP/IP. This is defined in RFC1006.

Supported Commands
FB14-GET (S7-300)
FB15-PUT (S7-300)
SFB14-GET (S7-400)
SFB15-PUT (S7-400)

Libraries
This driver requires a standard Ethernet card. No special libraries or hardware are needed.

Note: To communicate with this driver, devices require specialized ladder programming.

Channel Properties
Device Properties
Master Device Configuration
Appendix: Configuring Connections Using the SIMATIC Manager

Channel Properties - General
This server supports the use of simultaneous multiple communications drivers. Each protocol or driver used
in a server project is called a channel. A server project may consist of many channels with the same
communications driver or with unique communications drivers. A channel acts as the basic building block of
an OPC link. This group is used to specify general channel properties, such as the identification attributes
and operating mode.

Identification

Name: User-defined identity of this channel. In each server project, each channel name must be unique.
Although names can be up to 256 characters, some client applications have a limited display window when
browsing the OPC server's tag space. The channel name is part of the OPC browser information.
For information on reserved characters, refer to "How To... Properly Name a Channel, Device, Tag, and Tag

Group" in the server help.

Description: User-defined information about this channel.
 Many of these properties, including Description, have an associated system tag.

Driver: Selected protocol / driver for this channel. This property specifies the device driver that was selected
during channel creation. It is a disabled setting in the channel properties.
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Note: With the server's online full-time operation, these properties can be changed at any time. This
includes changing the channel name to prevent clients from registering data with the server. If a client has
already acquired an item from the server before the channel name is changed, the items are unaffected. If,
after the channel name has been changed, the client application releases the item and attempts to re-
acquire using the old channel name, the item is not accepted. With this in mind, changes to the properties
should not be made once a large client application has been developed. Utilize the User Manager to prevent
operators from changing properties and restrict access rights to server features.

Diagnostics

Diagnostics Capture: When enabled, this optionmakes the channel's diagnostic information available to
OPC applications. Because the server's diagnostic features require a minimal amount of overhead
processing, it is recommended that they be utilized when needed and disabled when not. The default is
disabled.
Note: This property is disabled if the driver does not support diagnostics.
For more information, refer to "Communication Diagnostics" in the server help.

Channel Properties - Ethernet Communications
Ethernet Communication can be used to communicate with devices.

Ethernet Settings

Network Adapter:  Specify the network adapter to bind. When Default is selected, the operating system
selects the default adapter.

Channel Properties - Write Optimizations
As with any OPC server, writing data to the device may be the application's most important aspect. The
server intends to ensure that the data written from the client application gets to the device on time. Given
this goal, the server provides optimization properties that can be used to meet specific needs or improve
application responsiveness.

Write Optimizations

Optimization Method: controls how write data is passed to the underlying communications driver. The
options are:

l Write All Values for All Tags:  This option forces the server to attempt to write every value to the
controller. In this mode, the server continues to gather write requests and add them to the server's
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internal write queue. The server processes the write queue and attempts to empty it by writing data
to the device as quickly as possible. This mode ensures that everything written from the client
applications is sent to the target device. This mode should be selected if the write operation order or
the write item's content must uniquely be seen at the target device.

l Write Only Latest Value for Non-Boolean Tags: Many consecutive writes to the same value can
accumulate in the write queue due to the time required to actually send the data to the device. If the
server updates a write value that has already been placed in the write queue, far fewer writes are
needed to reach the same final output value. In this way, no extra writes accumulate in the server's
queue. When the user stops moving the slide switch, the value in the device is at the correct value at
virtually the same time. As the mode states, any value that is not a Boolean value is updated in the
server's internal write queue and sent to the device at the next possible opportunity. This can greatly
improve the application performance.

Note: This option does not attempt to optimize writes to Boolean values. It allows users to
optimize the operation of HMI data without causing problems with Boolean operations, such as a
momentary push button.

l Write Only Latest Value for All Tags:  This option takes the theory behind the second optimization
mode and applies it to all tags. It is especially useful if the application only needs to send the latest
value to the device. This mode optimizes all writes by updating the tags currently in the write queue
before they are sent. This is the default mode.

Duty Cycle: is used to control the ratio of write to read operations. The ratio is always based on one read for
every one to ten writes. The duty cycle is set to ten by default, meaning that ten writes occur for each read
operation. Although the application is performing a large number of continuous writes, it must be ensured
that read data is still given time to process. A setting of one results in one read operation for every write
operation. If there are no write operations to perform, reads are processed continuously. This allows
optimization for applications with continuous writes versus a more balanced back and forth data flow.

Note: It is recommended that the application be characterized for compatibility with the write
optimization enhancements before being used in a production environment.

Channel Properties - Advanced
This group is used to specify advanced channel properties. Not all drivers support all properties; so the
Advanced group does not appear for those devices.

Non-Normalized Float Handling: Non-normalized float handling allows users to specify how a driver
handles non-normalized IEEE-754 floating point data. A non-normalized value is defined as Infinity, Not-a-
Number (NaN), or as a Denormalized Number. The default is Replace with Zero. Drivers that have native
float handling may default to Unmodified. Descriptions of the options are as follows:

l Replace with Zero:  This option allows a driver to replace non-normalized IEEE-754 floating point
values with zero before being transferred to clients.

l Unmodified:  This option allows a driver to transfer IEEE-754 denormalized, normalized, non-
number, and infinity values to clients without any conversion or changes.
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Note: This property is disabled if the driver does not support floating point values or if it only supports the
option that is displayed. According to the channel's float normalization setting, only real-time driver tags
(such as values and arrays) are subject to float normalization. For example, EFM data is not affected by this
setting.

For more information on the floating point values, refer to "How To ... Work with Non-Normalized Floating
Point Values" in the server help.

Inter-Device Delay: Specify the amount of time the communications channel waits to send new requests to
the next device after data is received from the current device on the same channel. Zero (0) disables the
delay.

Note: This property is not available for all drivers, models, and dependent settings.

Channel Properties - Communications Properties

Port Number: Specify the port number on which the driver listens. Devices must be configured to connect
to this port: messages sent to all other ports are ignored by the driver. The valid range is 0 to 65535. The
default setting is IE TCP/IP: 102 (TSAP).

Note: Non-standard values may be required by routing and firewall issues.

Device Properties - General
A device represents a single target on a communications channel. If the driver supports multiple controllers,
users must enter a device ID for each controller.

Identification

Name:  This property specifies the name of the device. It is a logical user-defined name that can be up to
256 characters long, andmay be used onmultiple channels.
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Note: Although descriptive names are generally a good idea, some OPC client applications may have a
limited display window when browsing the OPC server's tag space. The device name and channel name
become part of the browse tree information as well. Within an OPC client, the combination of channel name
and device name would appear as "ChannelName.DeviceName".

For more information, refer to "How To... Properly Name a Channel, Device, Tag, and Tag Group" in server
help.

Description: User-defined information about this device.
Many of these properties, including Description, have an associated system tag.

Channel Assignment: User-defined name of the channel to which this device currently belongs.

Driver: Selected protocol driver for this device.

Model:  This property specifies the specific type of device that is associated with this ID. The contents of the
drop-downmenu depends on the type of communications driver being used. Models that are not supported
by a driver are disabled. If the communications driver supports multiple device models, the model selection
can only be changed when there are no client applications connected to the device.

Note: If the communication driver supports multiple models, users should try to match the model
selection to the physical device. If the device is not represented in the drop-downmenu, select a model that
conforms closest to the target device. Some drivers support a model selection called "Open," which allows
users to communicate without knowing the specific details of the target device. For more information, refer
to the driver help documentation.

ID:  This property specifies the device's driver-specific station or node. The type of ID entered depends on
the communications driver being used. For many communication drivers, the ID is a numeric value. Drivers
that support a Numeric ID provide users with the option to enter a numeric value whose format can be
changed to suit the needs of the application or the characteristics of the selected communications driver.
The ID format can be Decimal, Octal, and Hexadecimal.

Note: If the driver is Ethernet-based or supports an unconventional station or node name, the device's
TCP/IP address may be used as the device ID. TCP/IP addresses consist of four values that are separated by
periods, with each value in the range of 0 to 255. Some device IDs are string based. There may be additional
properties to configure within the ID field, depending on the driver. For more information, refer to the
driver's help documentation.

Operating Mode

Data Collection:  This property controls the device's active state. Although device communications are
enabled by default, this property can be used to disable a physical device. Communications are not
attempted when a device is disabled. From a client standpoint, the data is marked as invalid and write
operations are not accepted. This property can be changed at any time through this property or the device
system tags.

Simulated:  This option places the device into Simulation Mode. In this mode, the driver does not attempt to
communicate with the physical device, but the server continues to return valid OPC data. Simulated stops
physical communications with the device, but allows OPC data to be returned to the OPC client as valid data.
While in Simulation Mode, the server treats all device data as reflective: whatever is written to the simulated
device is read back and each OPC item is treated individually. The item's memory map is based on the group
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Update Rate. The data is not saved if the server removes the item (such as when the server is reinitialized).
The default is No.

Notes:

1. This System tag (_Simulated) is read only and cannot be written to for runtime protection. The System
tag allows this property to be monitored from the client.

2. In Simulationmode, the item's memory map is based on client update rate(s) (Group Update Rate for
OPC clients or Scan Rate for native and DDE interfaces). This means that two clients that reference
the same item with different update rates return different data.

 Simulation Mode is for test and simulation purposes only. It should never be used in a production
environment.

Device Properties - Scan Mode
The ScanMode specifies the subscribed-client requested scan rate for tags that require device
communications. Synchronous and asynchronous device reads and writes are processed as soon as
possible; unaffected by the ScanMode properties.

Scan Mode: specifies how tags in the device are scanned for updates sent to subscribed clients.
Descriptions of the options are:

l Respect Client-Specified Scan Rate:  This mode uses the scan rate requested by the client.
l Request Data No Faster than Scan Rate:  This mode specifies the maximum scan rate to be used.

The valid range is 10 to 99999990 milliseconds. The default is 1000 milliseconds.
Note: When the server has an active client and items for the device and the scan rate value is

increased, the changes take effect immediately. When the scan rate value is decreased, the changes
do not take effect until all client applications have been disconnected.

l Request All Data at Scan Rate:  This mode forces tags to be scanned at the specified rate for
subscribed clients. The valid range is 10 to 99999990 milliseconds. The default is 1000 milliseconds.

l Do Not Scan, Demand Poll Only:  This mode does not periodically poll tags that belong to the
device nor perform a read to get an item's initial value once it becomes active. It is the client's
responsibility to poll for updates, either by writing to the _DemandPoll tag or by issuing explicit device
reads for individual items. For more information, refer to "Device Demand Poll" in server help.

l Respect Tag-Specified Scan Rate:  This mode forces static tags to be scanned at the rate specified
in their static configuration tag properties. Dynamic tags are scanned at the client-specified scan
rate.

Initial Updates from Cache: When enabled, this option allows the server to provide the first updates for
newly activated tag references from stored (cached) data. Cache updates can only be provided when the
new item reference shares the same address, scan rate, data type, client access, and scaling properties. A
device read is used for the initial update for the first client reference only. The default is disabled; any time a
client activates a tag reference the server attempts to read the initial value from the device.

Device Properties - CPU Settings
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Rack Number: This property specifies the number of the rack in which the simulated CPU of interest
resides. The valid range is 0 to 7. Devices must have unique rack and slot values. The default setting is 0.

CPU Slot: This property specifies the number of the slot in which the simulated CPU of interest resides. The
valid range is 0 to 31. Devices must have unique rack and slot values. The default setting is 0.

Master Device Configuration
Siemens PLCs must be programmed to issue read and write commands to the driver and to handle returned
data. For more information, refer to the Siemens PLC programming documentation. For information on
preparing the Master Device and the unsolicited driver for communications, refer to Configuring Connections
Using the SIMATIC Manager.

Messages must be sent to the IP address of the selected Ethernet adapter of the host computer running the
unsolicited driver. To do so, update the channel properties.
For more information concerning the port number configured for the simulated device, refer to

Communication Properties.
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Data Types Description

Data
Type

Description

Boolean Single bit

Byte Unsigned 8-bit value

Char Signed 8-bit value

Word Unsigned 16-bit value

bit 0 is the low bit
bit 15 is the high bit

Short Signed 16-bit value

bit 0 is the low bit
bit 14 is the high bit
bit 15 is the sign bit

DWord Unsigned 32-bit value

bit 0 is the low bit
bit 31 is the high bit

Long Signed 32-bit value

bit 0 is the low bit
bit 30 is the high bit
bit 31 is the sign bit

BCD Two byte packed BCD

Value range is 0-9999. Behavior is undefined for values beyond this range.

LBCD Four byte packed BCD

Value range is 0-99999999. Behavior is undefined for values beyond this range.

Float 32-bit floating point value.

The driver interprets two consecutive registers as a floating point value by making the second
register the high word and the first register the low word.

String NULL-terminated ASCII string
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Address Descriptions
The following information applies to both S7-300 and S7-400 models. The default data types for dynamically
defined tags are shown in bold.

Address Type Range Type Access
Discrete Inputs I0.b-I4095.b*

.b is Bit Number 0-7

IB0-IB4095

IW0-IW4094

IW:KT0-IW:KT4094

IW:KC0-IW:KC4094

ID0-ID4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD,
Float

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Discrete Inputs

Note: I and E access the same
memory area.

E0.b-E4095.b*
.b is Bit Number 0-7

EB0-EB4095**

EW0-EW4094

EW:KT0-EW:KT4094

EW:KC0-EW:KC4094

ED0-ED4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD,
Float

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Discrete Outputs Q0.b-Q4095.b*
.b is Bit Number 0-7

QB0-QB4095

QW0-QW4094

QW:KT0-QW:KT4094

QW:KC0-QW:KC4094

QD0-QD4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD,
Float

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Discrete Outputs A0.b- A4095.b* Boolean Read/Write
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Address Type Range Type Access

Note:Q and A access the same
memory area.

.b is Bit Number 0-7

AB0-AB4095

AW0-AW4094

AW:KT0-AW:KT4094

AW:KC0-AW:KC4094

AD0-AD4092

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD,
Float

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Internal Memory  F0.b-F4095.b*
.b is Bit Number 0-7

FB0-FB4095

FW0-FW4094

FW:KT0-FW:KT4094

FW:KC0-FW:KC4094

FD0-FD4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD,
Float

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Internal Memory

Note: F andM access the same
memory area.

M0.b-M4095.b*
.b is Bit Number 0-7

MB0-MB4095

MW0-MW4094

MW:KT0-MW:KT4094

MW:KC0-MW:KC4094

MD0- MD4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD,
Float

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Data Block Boolean DB1-N:KM0.b-
KM4094.b*
1-N is Block Number
.b is Bit Number 0-15

Alternates

Boolean Read/Write
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Address Type Range Type Access

DB1DBX0.b-
DBNDBX4094.b*
1-N is Block Number
.b is Bit Number 0-15

DB1D0.b-DBND4094.b*
1-N is Block Number
.b is Bit Number 0-15

Boolean

Boolean

Read/Write

Read/Write

Data Block Left Byte DB1-N:KL0-KL4095
1-N is Block Number

Alternates

DB1DBB0-
DBNDBB4095
1-N is Block Number

DB1DL0-DBNDL4095
1-N is Block Number

Byte, Char, String**

Byte, Char, String**

Byte, Char, String**

Read/Write

Read/Write

Read/Write

Data Block Right Byte DB1-N:KR0-KR4094
1-N is Block Number

Alternates

DB1DR0-DBNDR4094
1-N is Block Number

Byte, Char, String**

Byte, Char, String**

Read/Write

Read/Write

Data Block UnsignedWord DB1-N:KH0-KH4094
1-N is Block Number

Word, Short, BCD Read/Write

Data Block SignedWord DB1-N:KF0-KF4094
1-N is Block Number

Alternates

DB1DBW0-
DBNDBW4094
1-N is Block Number

DB1DW0-DBNDW4094
1-N is Block Number

Word, Short, BCD

Word, Short, BCD

Word, Short, BCD

Read/Write

Read/Write

Read/Write

Data Block Signed Long DB1-N:KD0-KD4092
1-N is Block Number

Alternates

DB1DBD0-
DB1DBD4092
1-N is Block Number

DWord, Long, LBCD,
Float

DWord, Long, LBCD,
Float

Read/Write

Read/Write
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Address Type Range Type Access

DB1DD0-DB1DD4092
1-N is Block Number DWord, Long, LBCD,

Float
Read/Write

Data Block Float DB1-N:KG0-KG4092
1-N is Block Number

Float Read/Write

Data Block BCD DB1-N:BCD0-BCD4094
1-N is Block Number

Word, Short Read/Write

Data Block S5 Timer as DB DB1-N:KT0-KT4094
1-N is Block Number

DWord, Long Read/Write

Data Block S5 Counter as DB DB1-N:KC0-KC4094
1-N is Block Number

Word, Short Read/Write

Data Block String DB1:S0.n-DB1:S4095.n*
.n is string length.
0<n<=218.

String Read/Write

*These memory types/subtypes do not support arrays.
**Byte memory types (MB) support strings. The syntax for strings is <address>.<length> where
0<length<=218.

Notes:

1. All offsets for memory types I, Q, and F represent a byte starting location within the specified memory
type.

2. Use caution whenmodifying Word, Short, DWord, and Long types. For I, Q and F, each address starts
at a byte offset within the device. Therefore, Words FW0 and FW1 overlap at byte 1. Writing to FW0
modifies the value held in FW1. Similarly, DWord, and Long types can also overlap. It is recommended
that these memory types be used so that overlapping does not occur. For example, when using
DWords, FD0, FD4, FD8 and so on should be used in order to prevent overlapping bytes.

Arrays
All memory types/subtypes support arrays (excepting those discussed above). The valid syntax for declaring
an array is described below. If no rows are specified, row count of 1 is assumed.

<address>[rows][cols]
<address>.rows.cols
<address>,rows,cols
<address>_rows_cols

For Word, Short, BCD and "KT" arrays, the base address+(rows*cols*2) cannot exceed 4096. The elements
of the array are words, and are located on a word boundary. For example, IW0[4] would return IW0, IW2, IW4
and IW6. "KT" subtypes fall into the 16-bit category because the data stored in the PLC is contained within a
Word.

For Float, DWord, Long and Long BCD arrays (excluding "KT" subtypes), the base address+(rows*cols*4)
cannot exceed 4096. Keep in mind that the elements of the array are DWords, located on a DWord
boundary. For example, ID0[4] returns ID0, ID4, ID8 and ID12.
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For all arrays, the total number of bytes being requested cannot exceed the internal block size of 218 bytes.

KL vs. KR vs. DBB
KL and KR determine whether the left byte or right byte of the data block word is returned.

Value 8 9 A B C

Byte 0 1 2 3 4

Example 1
DB1:KH0=0x89
DB1:KL0=0x8
DB1:KR0=0x9
DB1DBB0=0x8

Example 2
DB1:KH1=0x9A
DB1:KL1=0x9
DB1:KR1=0xA
DB1DBB1=0x9

Examples

l To access bit 3 of Internal Memory F20, declare an address as follows: F20.3

l To access Data Block 5 as wordmemory at byte 30, declare an address as follows: DB5:KH30

l To access Data Block 2 byte 20 and bit 7, declare an address as follows: DB2:KM20.7

l To access Data Block 1 as left byte memory at byte 10, declare an address as follows: DB1:KL10

l To access Internal Memory F20 as a DWord, declare an address as follows: FD20

l To access Input Memory I10 as a Word, declare an address as follows: IW10
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Event LogMessages
The following information concerns messages posted to the Event Log pane in the main user interface.
Consult the server help on filtering and sorting the Event Log detail view. Server help contains many
commonmessages, so should also be searched. Generally, the type of message (informational, warning)
and troubleshooting information is provided whenever possible.

Failure to start unsolicited communications. | Port number = <number>.
Error Type:
Error

Possible Cause:

1. The driver was not able to create a listen socket for unsolicited communications. Another application
may be using the port specified.

2. There may be low system resources.

Possible Solution:

1. Use network monitor software to see if another application is using the port. If so, shut down the
conflicting application and restart the OPC Server. If the conflicting application is free to pick any
available port, make sure the server is always started first so it can claim the required port. If both
the PLC programming software and this driver must use the same port, they may not be able to be
used simultaneously.

2. Verify there are adequate system resources or release resources from other processes.

Ã  See Also:
Channel Setup
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Appendix: ConfiguringConnections Using the
SIMATICManager
Connections are configured using the SIMATIC Manager software. The following topics provide information
on configuring the Siemens TCP/IP Unsolicited Ethernet Driver to run in unsolicited mode, and demonstrate
a basic setup using the S7-300 PLC as the active partner and the driver as the passive partner.

Note: The Siemens TCP/IP Unsolicited Ethernet Drivercan configure 256 devices, each with an associated
slot/rack. When the active partner (master) communicates with the passive partner (unsolicited driver), it
directs its requests to a specific device in the unsolicited driver. Multiple remote partners can talk to the
same device.

To jump to a specific section, select a link from the list below.

Step One: Creating a New Project
Step Two: Configuring the Master and PC Station
Step Three: Connecting the Master and the Slave Driver
Step Four: Inserting Function Blocks
Step Five: Creating the DB3 Data Block
Step Six: Inserting PUT FB
Step Seven: Downloading to the PLC

Step One: Creating a New Project
1. To start, open the SIMATIC Manager software and then create a new project. In this example, the

project being used is "Setup".
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Note: The project's main window should appear as shown below.

2. Next, create the Master and PC Station. To do so, right-click in the right pane of the window and then
select Insert New Object | SIMATIC 300 Station.

Note: The Master unit is the active partner or the image of the actual PC. The PC Station is the PC
on which the SIMATIC Manager software is running.

www.kepware.com
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Note: The SIMATIC 300 station should appear as shown below.
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3. Name the new station "MASTER," because it represents the communication's active partner.

4. Next, right-click in the right pane of the window and then select Insert New Object | SIMATIC PC
Station.

Note: The SIMATIC PC Station should appear as shown below.
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 For more information, refer to Step Two: Configuring the Master and PC Station.

Step Two: Configuring the Master and PC Station
Industrial Ethernet (IE) is the protocol used for communication.

1. To start, right-click in the right pane of the SIMATIC Manager window. Then, select Insert New
Object | Industrial Ethernet.

Note: The main window should now display an Ethernet icon.
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2. Next, select the MASTER icon in the left pane of the window. Then, double-click onHardware.

Note: The HW Config window should appear as shown below.

3. Next, open the View tab and select Catalog. Then, expand the SIMATIC 300 menu and the Rack 300
menu.
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4. To insert the racks, double-click on Rail.

5. Next, expand the PS 300menu. Double-click on PS 307 10A or any other suitable option to insert the
power supply into slot 1.
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6. To insert the CPU, expand both the CPU 300menu and the CPU 315-2 DP menu. Then, double-click
on the CPU that matches the hardware.
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7. To insert the CPU into slot 2, clickOK.

8. To insert the CP, leave slot 3 empty and then click on slot 4 in the racks.

9. Next, expand both the CP 300menu and the Industrial Ethernetmenu. Then, double-click on the CP
that matches the hardware.
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Note: The window should appear as shown below.
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10. Next, enter the PLC's IP address and subnet mask. Then, select Ethernet from the subnet box.

11. Click OK to configure the Master.
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Note: Once finished, open the View tab and then select Catalog to hide the catalog window.

12. Save and exit the HW Configuration window.

13. To configure the PC station, click on the SIMATIC PC Station in the left pane of the SIMATIC Manager
window. Then, double-click on Configuration.
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14. Next, click on the View tab and select Catalog.

15. Expand both the SIMATIC PC Station menu and the CP Industrial Ethernetmenu. Then, double-
click on IE General or any other suitable option.
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Note: The window should appear as shown below.
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16. Enter the IP address of the PC running the SIMATIC Manager software, in addition to the correct
subnet mask.

17. Next, select Ethernet from the subnet box. Then, clickOK to configure the PC station.
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Note:Once finished, open the View tab and then select Catalog to hide the catalog window.

18. Save and exit the HW Configuration window.

For more information, refer to Step Three: Connecting the Master and the Slave Driver.

Step Three: Connecting the Master and the Slave Driver
Once the Master and the PC Station have been successfully configured, the Master and the Slave Driver
must be connected.

1. To start, open the Options tab in the SIMATIC Manager window and then select Configure Network.
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2. Next, click on the Master's CPU 315-2 DP block. A series of rows should be displayed in the lower
half of the window.
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3. Right-click on the first row and select Insert New Connection.

4. Then, clickOK.
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Note: The window should appear as shown below.

5. Next, enter the IP address of the machine on which the Siemens TCP/IP Unsolicited Ethernet Driver
runs.
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6. Next, click Address Details and enter the rack/slot values of the device in the unsolicited driver with
which the Master should communicate.

7. Once finished, clickOK twice to successfully connect the master and slave drivers. The master uses
these settings to communicate with the destination device at rack 0 and slot 2.
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Note: The Local ID number (=1) identifies the connection between the two partners. This number is
used later when creating function blocks for reading and writing data.

8. To finish, save and compile the data by opening the Network tab and selecting Save and Compile.
Then, clickOK.

Note: There should be no errors on compilation.

For more information, refer to Step Four: Inserting Function Blocks.
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Step Four: Inserting Function Blocks
Once the master has been configured and connected with the unsolicited driver, it must also be prepared to
generate requests for the unsolicited partner. This is done by creating function blocks, which can be used to
read data from or write data to an unsolicited driver. The function block (FB) used for reading data in this
example is FB14 (GET). The function block (FB) for writing data is FB15 (PUT).

1. To start, expand the Master menu, the CPU 315-2 DP menu, and the S7 Program[1]menu.

2. Next, double-click on Blocks andOB1.

3. LAD, STL, or FBD can be used to create function blocks. In this example, FBD is used. In the
LAD/STL/FBD window, click on the Insertmenu.
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4. Then, click Program Elements.

5. Next, expand the Libraries, SIMATIC_NET_CP, and CP 300menu. Then, double-click on FB14 GET to
insert a function block to read data.
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6. Close the Program Elements window. "FB14" should be inserted as shown below.

7. Next, associate a data block (DB) with the function block (FB). To do so, click above the FB where
there are three red questionmarks.
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8. Enter the name of a data block. In this example, it is "DB2".

9. Next, click Yes to create the data block.

10. Next, fill in the other details as appropriate for the fields in the function block. Users should consider
the following:
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l "ADDR_1" is the address on the destination device in the unsolicited driver.

l "RD_1" is the address local to the PLC.

l The value at the remote address specified by "ADDR_1" is written (GET) to the local address
specified by "RD_1".

l Enter the Local ID number that was generated when setting up the connection between the
Master and the Slave Driver in the ID field. In this example, the Local ID number is 1.

The number of bytes in both the "ADDR_1" and "RD_1" fields should be same for the
unsolicited driver to respond correctly. Otherwise, an error occurs.

Note:Now that the GET function block has been created successfully, users must remember that
the block gets executed/triggered only on a rising edge (REQ).
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11. To finish, click Save and then close the LAD/STL/FBD window.

For more information, refer to Step Five: Creating the DB3 Data Block.

Step Five: Creating the DB3 Data Block
While configuring GET FB, the data block "DB3" was used for the "RD_1" field. This is the data block that will
store read values.

1. To start, right-click in the right pane of the SIMATIC Manager window and then select Insert New
Object| Data Block.

2. Next, change the name to "DB3."
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Note: The window should appear as shown below.

3. Next, double-click onDB3. In order to assign some memory to the data block, users canmake
changes similar to those shown in the window below. Although the array size in this example was
chosen arbitrarily, values should be specified to fit a particular need.
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4. Once finished, save and close the LAD/STL/FBD window.

For more information, refer to Step Six: Inserting PUT FB.

Step Six: Inserting PUT FB
1. Next, create a separate data block for the PUT FB, which holds the data that is written to the remote

partner. To insert this new data block, follow the steps in Step Five: Creating the DB3 Data Block
but name it "DB5."

2. Double-click onDB5, and then specify a memory size. Although the array size in this example was
chosen arbitrarily, the values should be specified to fit a particular need.

www.kepware.com

49



Siemens TCP/IP Unsolicited Ethernet Driver

3. To insert the PUT FB, double-click onOB1 in the SIMATIC Manager window. In LAD/STL/FBD, right-
click in the blank space below GET FB.
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4. Next, click Insert Network and then select the blank space below.

5. Next, click Insert | Program Elements. Then, expand the Libraries, SIMATIC_NET_CP, and CP 300
menus.

6. To insert a function block to write data, double-click on FB15 PUT. Then, close the Program
Elements window.
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7. Next, associate a data block (DB) with the function block (FB). To do so, click above the FB where
there are three red questionmarks. Then, specify a name. In this example, "DB4" is used.

Note: A window prompt requests confirmation of data block creation. Click Yes.

8. Fill in the other details as appropriate. Users should consider the following:

l "ADDR_1" address is on the destination device in the unsolicited driver.

l "SD_1" is the address local to the PLC.

l The value at the local address specified by "SD_1" is written (PUT) to the remote address
specified by "ADDR_1".

l Enter the Local ID number that was generated when setting up the connection between the
Master and the Slave Driver in the ID field. In this example, the Local ID number is 1.

Important: The number of bytes in both the "ADDR_1" and "SD_1" fields should be same in
order for the unsolicited driver to respond correctly. Otherwise, an error occurs.
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9. To finish, click Save and then close LAD/STL/FBD.

For more information, refer to Step Seven: Downloading to the PLC.

Step Seven: Downloading to the PLC
Once the Master has been prepared to generate Read/Write requests for the remote unsolicited partner,
the informationmust be downloaded to the PLC.

1. To start, clickMaster in the left pane of the SIMATIC Manager window. Then, select the PLC menu.
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2. Next, select Download to begin downloading the project to the PLC.

3. ClickOK.

4. Then, click Yes.
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Note: The master must be run in order to trigger the function blocks that generate Read/Write
requests.

5. Double-click onOB1 in the SIMATIC Manager window.

6. In LAD/STL/FBD, click Debug | Monitor.
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Note: LAD/STL/FBD should appear in Online Mode as shown below.
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7. To execute GET/PUT FBs, change the REQ value to 0 and then 1 to indicate the rising edge. To do
so, right-click on the REQ field and selectModify to 0 to force a zero to the field.
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8. Next, right-click on the REQ field and selectModify to 1 to force a value of one to the field.
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Note: Both of the FBs must next be configured to respond to the same rising edge in order for the
SIMATIC Manager's variables to be locally monitored andmodified.

9. In LAD/STL/FBD, click on PLC and then selectMonitor/Modify Variables.

10. Enter the variables to be monitored. To view the changes made to this window, execute the function
blocks.

Note: Remember that the slot/rack value of the remote device with which the master is
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communicating is "rack:0 slot:2". The values can be changed from the NetPro window. Users must
make sure that the unsolicited driver on the other end has a device with these values and is running.
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